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7E MPLAB X IDE H. /5 5 File -> New Project, 1E$£“32-bit MPLAB Harmony Porject”,
SRJE i “Next” $%4H.

Bd New Project

Steps

Choose Project

=

1. Choose Project
R —

Q, Filter:
Categories: Projects:
1) Microchip Embedded k=il 32-bit MPLAB Harmony 3 Project
. ) Other Embedded @ 32-bit MPLAB Harmony Project
1) Samples [l Standalone Project
: [4a) Existing MPLAB IDE v8 Project
m Prebuilt {Hex, Loadable Image) Project
[ia] User Makefile Project
m Library Project
[eal Import START MPLAB Project
[52] Import Atmel Studio Project
Description:

MPLAB® Harmony Project Wizard

< Back Finish Cancel ” Help

EFE “Harmony Framework” HISERREER, SAJ5 M “Next” #4241,
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B3 New Project

x
Steps Manage Framework
1. Choose Project
2. Framework Selection Use the Framework Downloader tool to download or configure a local framework.
3. Project Settings
4.

Configuration Settings Launch Framework Downloader |

Framework Path: I C:\microchip\H3_installpath I

Convert to Relative Path for Configuration

ISEPRIL-ES T

< Back Mext = Finish Cancel

HE T H BARAIIH 28K, )5 e “Next” 24

Help

B3 New Project

Steps Name and Location
1. Choose Project
2. Framework Selection Location: C:\Users\Desktop\temp'\harmony3\E70\E70_EX1
3. Project Settings
4. Configuration Settings Folder: E70-LCC_GFX-0-BASIC.X
Name: E70-LCC_GFX-0-BASIC.X
Path:

C:\Users\Desktop\temp\harmony3\E70\E70_EX1\firmware\E70-LCC_GFX-0-BASIC.X.X

< Back Finish Cancel Help

RPN 2R A “ATSAME70Q21B”, )5 fidi “Finish” #%4H .
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¥ New Project b4

Steps Configuration Settings

1. Choose Project

2. Framework Selection Name: default

3. Project Seftings

4. Configuration Settings
Device Family: | All ~ |  Target Device: | RYEEAGIS{[ephl:) ~
Device Filter:

ISEPRIE LIS L

< Back MNext > Cancel Help

(=) 1 MHC kBB SAME70 Xplained Ultra 1%
F—ROEBEHKN, MHC i< A3NES). 8EF3N7E X IDE B A& Tools ->
Embeded -> MPLAB Harmony 3 Configurator J33/]:

samd21_debug_uart : default
2 Source Refactor Production Debug Team Window Help
2 [default =) :ﬂ*‘ - I:f& Embedded » 2 MPLAB® Harmony 3 Framework Downloader
- Licenses 2 MPLAB® Harmony 3 Configurator I
Apply Diff Patch...

ISSES Services
1art

Templates
DTDs and XML Schemas

Plugins
Plugins Download

Options

Ak Fogfx, M “Launch” #%41)3 3l MHC,
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2 Configuration Database Setup X

Select and configure the packages that will be included in the current project:

o9
Load  Name Version Dependencies
| |bsp core(3.0)
| |core csp(3.0)
| |crypto core(3.0)
csp
Ll lafx | v3.1.0 core(3.0)
/| Inet core(3.0)
| Jusb v3.1.0 core(3.0)

Configure Device Family and CMSIS Pack Paths:

DFP: |.\de'v_packs\M\croch\p\SAME?U_DFP\2.4.148\same70b\atdf\ATSAME?UQZlB.atdf | lII

CMSIS: |.\dev_packs\arm\CMSIS\S.4.[I | IIl

Launch | ‘ Cancel |
MHC F i+~ &
2 MPLAB Harmony Configurator - default - O X
File Generate Tools Utilities Window
! [ $) | §iPode) Framework: C:\microchip\H3_installpath),
(] Available Components = F4 53| (] Project Graph = Ff B3| |(] configuration Options =FH 0
+ X CRERE 4| = ClE

Board Support Packages (BSPs) ) = System
Graphics | System | Device & Project Configuration
Harmony Cortex-M7 Configuration
Input Clock (PMC)
Libraries Parts (P10)
N Interrupts (NWVIC)
Peripherals DM (M)
Third Party Libraries REWDT
Tools WOt

(] Available Components | (] Active Components | (] Configuration Options ' (] Help |

(] Console =HE

<Harmony Databases[Info]:
<Harmony Databases[Info,
<Harmony Database>[Info
<Harmony Database>[Info
<Harmony Databases[Info,
<Harmony Databases[Info,

create component: AT24 Driver ~
create component: AT25 Driver
create (DII'IPDI'IEIT'Z: SDHC Driver
create (DII'IPDI'IEIT'Z: SDSPI Driver
Load Module: Harmony TCP/IP stack
create component: USB Driver
<Harmony Database-[Info]: create component: USB Device CDC
<Harmony Database>[Info]: create component: USB Device Audio
patahase=lTInfol: create c - ISR Dewice HID

Welcome to the MPLAB Harmony Configurator!

7SN BSP, B”SAM E70 Xplained Ultra BSP” M ”Available Components” % I #Ji
Fl)”project Graph” & I
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= Board Support Packages (BSPs; ~
- Default Board (BSP)

-~ SAM E70 Xplained BSP
#- Graphics
#-Harmony
- Input
i Libraries 4
£ >

(] Available Components = B (] Project Graph =B
+ X CRERE4| = 5| View: |Root v

Device Family Pack (DFP) CMSIS Pack
SAM E70 Xplained Ultra BSP

[EFETT v, USHNAEAR “Aria Graphics w/ PDA TM4301B Display” .

(] Available Components

=

= O

& Board Support Packages (BSPs)
- Default Board (BSP)

“ SAM E70 Xplained BSP

= Graphics

- Displays

Driver

- GFX Core

Middleware

@ Processor

® Aria Graphics w/ PDA TM4301B Displa
“- Aria Graphics w/ Xplained Pro Display
H-Harmony

- Input

& Libraries

& Peripherals

- Third Party Libraries
& Tools

[] Awvailable Components | [] Active Components |

(] Project Graph
X ETRERE®| © F|

Device Family Pack (DFP) CMSIS Pack
SAM E70 ¥plained Ultra BSP

Aria Graphics w/ PDA TM4301B Display

FEVRINEAR “Aria Graphics w/ PDA TM4301B Display” 2 J&, 4= E shifH — R 4%t

OHE, ARFI P, FEARAT:

BN B SO Z A B A, EFE yes.
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Confirm Component Auto-Activation? X

IQ The database is requesting auto-activation of the following components:

Core (HarmonyCore)

Input System Service (sys_input)

GFX Core (gfx_hal)

Aria (aria_gfx_library)

PDA TM4301B (gfx_disp_pdatm4301b_480x272)
MaxTouch Controller (gfx_maxtouch_controller)
SMC (smc)

LCC (gfx_driver_lcc)

TWIHSO (twihs0)

12C (drv_i2c)

TCO (tc0)

TIME (sys_time)

Are you sure you want to activate these components?

No

i\ A& 5B FreeRTOS, AGIAT 2 0S, ¥ No.

Confirm Component Auto-Activation? *

'ﬂ_- The database is requesting auto-activation of the following components:
FreeRTOS (FreeRTOS)

Are you sure you want to activate these components?

Yes ] No

BN BB, 1L yes.

Confirm Attachment Auto-Connect? X

la The database is requesting automatic connection following component attachments:

afx_hal:gfx_display -> gfx_disp_pdatm4301b_480x272:gfx_display
aria_gfx_library:gfx_hal -> gfx_hal:gfx_hal

gfx_maxtouch_controlleritouch_panel -> gfx_disp_pdatm4301b_480x272:touch_panel
gfx_driver_lcc:SMC_CS -» smcsmc_cs0

afx_hal:gfx_display_driver -> gfx_driver_lcc:gfx_driver_lcc
drv_i2c_O:drv_i2c_12C_dependency -> twihsO:TWIHSO_12C
gfx_maxtouch_controlleri2c -» drv_i2c_O:drv_i2c
sys_time:sys_time_TMR_dependency -> tc0:TCO_TMR

Are you sure you want to automatically make these connections?

Yes No

B AR A I PR, EFE ves.
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Confirm Component Deactivation? X

| E—l The following components are going to be deactivated:

Are you sure you want to deactivate these components?

Yes No

AAFIRINAEL SR, T

(] Project Graph = 5
X ECRERET| © 5| View: |Root v

Device Family Pack (DFP) CMSIS Pack Core

Harmony Core Service
o RTOS
Systemn Service Core Service O
GFX Core Input System Service
Hardware Abstraction Layer Aria
craphics Display PDA TM4301B Graphics Library
Display Driver e 480x272 PCAP Display < Input System Service
GFX HAL
MaxTouch Controller
Touch Controller
SMC < Input System Service

‘ Graphics Processor

Peripheral Library
LCC Display Driver SMC_CSsn
o sys dma SMC_CS1
O sys_int SMC CS2 12C
SMC_CS
Display Driver

SMC_CS3

Instainces -=—

Instance 0
Peripheral Library Systemn Service

TMR O Core Service
SYS TIME ©
TMR

Aria Graphics w/ PDA TM43201B Display
Aria Graphics w/ PDA TM4301B Display

RiEEH CHEL, HE—TAHRRAE.
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(] Project Graph = O
XCRERE4+| & 5| view: [Root o

Device Family Pack (DFF) CMSIS Pack SAM E70 Xplained Ultra BSP

Aria Graphics w/ PDA TM4301B Display Input System Service Core
Aria Graphics w' PDA TM4301B Display System Service Harmony Core Service
Input System Service © & RTOS

Core Service <

SMC LCC GFX Core Aria
Peripheral Library LCC Display Driver Hardware Abstraction Layer Graphics Library
SMC_CS0 < O sys_dma .~ Graphics Display O Input System Service
SMC_CS1 O sys_int Display Driver v~ GFX HAL
SMC_CS2 SMC_CS Graphics Processor

SMC_CS3 Display Driver GFX HAL
TIME
System Service
2 Core Service

SYS_TIME ©

TWIHSO0 12C [ TCO
Peripheral Library Crriver Peripheral Library
I2c & Core Service

MaxTouch Controller
Touch Controller

PDA TM4301B & Input System Service

480x272 PCAP Display DRV I2C

Graphics Display ? 4‘
Touch Panel < S e Touch Panel

M R I E, ST 44 T DA FH BRI RIAT
2 MPLAB Harmony Configurator - default®

File_@perate Tools Utilities Window

i l-'_:b ':pr? ;,.E.:-d;:_

2 Save Database State As x

Save in: default b £ B~

s

—
Recent Items

Desktop

Documents

This PC
g File name: default.xm|
Network  Files of type: [ = yem) > Save selecte

(=) R MHGC(Microchip Harmony Graphics Composer) il & I 5 11
MHC 332 Tools-> Graphics Composer 3K Ji 5] MHGC.

10
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File Generate Tools Utilities Window

J 2 4 Clock Configuration

Display Manager
DMA Configuration - &0
Graphics Composer
MPU Configuration SPS)
NVIC Configuration

(1 Available Col

Pin Configuration

E| Grabnhics

7654 H 1) Welcome Dialog” H i 7 55—/ M4l , S+ HF”new project wizard” X & HE

2 Welcome Dialog X

ey Graphics Composer
e

Welcome to the MPLAB Harmony Graphics Composer user interface design application.

Please select from one of the choices below to get started. You can also click the close button to begin using the tool
without guided assistance.

E Create a new project using the new project wizard.

Load an existing design from an MPLAB Graphics Composer data file.

/ Use design loaded from current MHC configuration.

["] pon't show this dialog again. Close

—

" Welcome Dialog”i%H HZI# H, WIFE MHGC ) L E A=A fioh dn N4 k4T
H”new project wizard” X iEHE . T WAL B Welcome Dialog HEIFH I, E5%
PSRBT o

[ =]

2 MPLAB Harmony Graphics Composer

File Edit View Asset Tools Window
] ek ¥ RCEOIL NN |

Color mode %% RGB565, #RJ& M. Next $24H

11
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2 New Project Wizard X

I Graphics Composer
R

Calor Mode Selection

Color Mode

Memory Size Select the color mode to use for this project. The color mede determines the color
depth, pixel storage format, and memory requirements for the design.

Pro]ect Type not all display devices and display drivers support all color modes. You must

Finish ensure that your display device and driver support the selected color mode

@]

O RGB_332 8 bits 3 bits red, 3 bits green, 2 bits blue

8 bits Greyscale

|® re 565 16bits 5 bits red, 6 bits green, 5 bits red |

O RGBA_5551 16 hits 5 bits red, 5 bits green, 5 bits blue, 1 bit alpha
O RGB_8a8 24 bits 8 bits red, 8 bits green, 8 bits blue
O RGBA_8888 32 bits 8 bits red, 8 bits green, 8 bits blue, 8 bits alpha

OARGEJEEE 32 bits 8 bits alpha, 8 bits red, 8 bits green, 8 bits blue

[ use Global Color Palette  The global color palette provides the means to use hoth
8 bit frame buffers and display 16-32 bit color depth.
The limitation is that the color palette of the design is

limitad +n 75A ralare Tha dicnlar driviar mnct cinnark

Estimated size of a single frame buffer (bytes): 261120

Note: Your display driver ma uire additional configuration in MHC nd
what is shown here.

Bra50¢
Next Cancel
Flash memory size fi HERIAME, 2R )5 s Next 324
Z New Project Wizard
«amuony - Graphics Composer
\v/
Color Mode Memory Size Configuration
MEMDI’Y Size Use the controls below to configure the amount of flash memory you want to use for
memary consumption analysis. Additional memory sources can be added through the
Prc-ject Type "Memory Location" configuration window.
Finish
Flash Memory Size (bytes): 524,288 5
Previous Cancel

12
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1 FE”Start a new project using a basic template”, B FHIEAEFAR , SR 5 i Next
&5

2 New Project Wizard Py
pLaB ] hi
nasveny - Graphics Composer
'L\'v/'
Color Mode New Project Contents
Memory Size Select from one of the choices below regarding the state of the new project.
PI‘OjECt Type () start a new project using a completely blank design.
Finish ® Start a new project using a basic template. This template includes a single screen, |
a few widgets, images, strings, and a default font.
Previous Mext Cancel

B Ja i 52 %, Screen Designer 7 1 HH B AL RARE AR 1) B T

2 MPLAB Harmony Graphics Composer® — ] x
File Edit View Asset Tools Window
EEEEELT RIS % v | o0
(] Tree View = F9 1| (1 Screen Designer - screenl = B B3| 1 widget Tool Box = &5
BT A === a
B &3 L:ayerD | 480 M Arc
- &= LogoWwidget I } Ik Bar Graph
i A TitleLabel Button
“- [o¥] SloganButton B | Check Box
¢ MPLAB Harmony Graphics Composer O cirde
- (A Circular Gauge ©
(1 Sereens | MPLAB (] Properties Editor - HE
all| 8l
e x|mm|t+ HARMONY ol
; : v Bl Screen A
Generate Visible HName View v Name screent
b o screenl - Size [480,272]
Orientation DEGREES 0
R Mirrored
(1 Schemes =&FE Modify. Generate. Run |  life Cycle
T EXD PP Persistent [ v
O Buante
< >
w
(Mouse over a property for detailed help)
screenl X

KR TREAIEE W, 7 LFEFF LM MHGC.

2 MPLAB Harmony Graphics Composer*

File Edit View Asset Tools Window

PlEee xup e =R Q[CE

- @EI‘ C
=

13
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(MO) fEH MHC 4 BRARES
B3] MHC 541, .5 generate code #2414 ACHY o

£ MPLAB Harmony Configurator - default : C\

File Generate Tools Utilities Window

EERAAHCE, M Save #40.

2 Modified Configuration

Current configuration has been modified. Do you want to save it before file generation?

C:\Users\A50814\Desktop\temp\harmony3\E70\EZ0_EX1\firmware\src\config\default\default.xml

Save

Save As

7 generate %41l <T Merge Strategy, HZH M xF .

2. Generate Project

1. Configure Generation Settings
= Generate Settings

Merge Strategy USER ALL

i .

(Mouse over a property for detailed help)

2. View Warnings

Type Description

3. Click Generate

I Generate Cancel

A A

14
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2 Generating Project.. %
Task Type Remaining Total

File Markup 0 336
File Copy 209 336
Libraries 0 0
Settings 6| 6
Source Paths 0 0

Generating file: C:\microchip\H3_installpath\dev_packs\Microchip\SAME70_DFP\2.4.148\same70b\include_mcc\component\twihs.h

68% Please Wait...

RS RRETR 5, W RASE ] MHC.

(F) i T B
7F MPLAB X IDE [¥] projects & 11, 47 88 . P21+ properties RFT - LIEJB I E 1.

15
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B4 MPLAB X IDE v5.10 - E70-LCC_GFX-0-BASIC.X : default
File Edit View Mavigate Source Refactor Production Debug Team

E%Lc%_ldefault M ?‘% D‘

Projects x| Files | Classes | = ‘@ ou
=] _E70-1CC_GRX-0-RASTCY ]| |
I [ Header Files New >
[iF Important File
. Linker Files Add Existing ltem...
Source Files Add Existing Items from Folders... ,

: " app.c

MNew Logical Folder
main.c Locate Headers

""" - Libraries Add Item to Important Files... .
----- ‘(& Loadables .

Unset as Main Project
70-LCC_GFX-0-BASIC

Open Required Projects ¥

28 EI@w Device
E‘a ..... @ ATSAME Close .
-8 Checksur =
= = i Packs Rename.. i
@ ----- i@l SAME70_ Maove...
iEj ..... ; CMSIS [5 CO
=5 Compiler To Py
T XC32 (V2 Delete Delete
- Productio .
% License: Code Assistance >
E—}-ﬁ Memaory )
= Data 393, Find..
Versioning >
@ Data | :
Histo >
=& Program v
< Properties

1% SAME70 Xplained Ultra #i%f M. [) EDBG 1l XC32 4 4% o

16
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Supported Plugin Board:
A None ~

Hardware Tool: Compiler Toolchain:

-0 JTTAGICE3 ~ | | Compiler Toolchains
- PICKit2 --ARM
-0 Power Debugger K e
=k | Microchip Kits R 18X C32 (v2.15) [C:\Program Files (x86)\Microchit
.. NEDBG L0 ¥C32 (v2.10) [C:\Program Files (x86)\Microchip
St
=00 MEDBG

—@ Starter Kits (PKOB)
—00 Curiosity/Starter Kits (PKOB4)
=l | Legacy Starter Kits

@ SKDE 33 AUDIO
@ SKDE Memory
@ SKDE PIC18F)
@ SKDE PIC24F 1
@ SK htll I >

D.l—_nrm..u_l_a:ugn.nl
] Mot Supported
to use a frlendlyL'mﬂ're-[FleTrsrea'J.

£l LA 19" Make and Program K52 A4 ATE %

- —_——— - . _

T8 [T Qoo o o8

Bk Ia, BATEIR W K

17
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. BE

ASCiERL MHC i B SAME70 Xplained Ultra A1l MHGC B KL TS, 23l
ESHATYNI )

2 B s ) TR RIS B SO i 255

Harmony3 %% H 5% \gfx_apps

Harmony3 %3 H 5% \gfx_apps\doc\help_apps_gfx.chm

KT LCC, mTLAZZE App note:

Using PIC32 MCUs to Develop Low-Cost Controllerless (LCC) Graphics Solutions
http://ww1.microchip.com/downloads/en/AppNotes/00001387C.pdf

ZAYSIN (i >3

(—) BECE H33H Welcome Dialog X} 15 HE
1E MHGC 1] 3¢ 8 i 5 File -> Settings, 1 Project and User Settings X ififE

2 MPLAB Harmony Graphics Compuoser

File Edit View Asset Tools Window
New |:ﬁ:%£ﬂ|'|i|'|zl|m\ C‘.\|
=70

Save -
+TF+ 3

Save As

Import
Export

Settings

Exit

1E Project and User Settings '] General T[], ‘2)i% Show Welcome Dialog & i%HE .

2 Project and User Settings s

Color Settings
- Show Welcome Dialog:

Preemption Level: LEVEL_O o

Hardware Acceleration:

19
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(=) 3XT Merge Strategy

1E Generate Project X[ 1EHEH A 4 Ff Merge Strategy. HARMEREUNT :
X

2 Generate Project

1. Configure Generation Settings

= Generate Settings
Merge Strategy USER _ALL ~

ALL

USER ALL

USER_RECENT

OVERWRITE

(Mouse over a property for detailed help)

2. View Warnings

Type Description

3. Click Generate

‘ Generate ‘ Cancel

ALL:  MHC ZE FRIR I A7 SCAF St 9 2 11

USER_ALL: MHC A= i) 3 HLIT ™ et el () SCPF i s 4 9 2
USER_RECENT: MHC A= e B ) I A 24l () SCPF 5 R 3
OVERWRITE: MHC ZEJi ({1 3CfF FL 127 o DARTZE s SO, RIS &R & 1 .

RKEGIHE D, TEEDE S ARSI N S, AlE DRI SRR,
G SRR B A R A S T SR O N AR, e A Sk B LR AT B AT
GRS A DR P IR SO N 2, AT AR ERD AT,

20
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2 Merging: libaria_demo_mode.c_411933553158288826.0ld

X

Pending Merge Actions: 1 Next Previous
Note: The content of the right pane displays the current state of this merge.
Generated Code 1/1 Current File: libaria_demo_mode.c_411933553158288826.old
HodsBxents. demoEvents[demoModeByents. muEyents]. v = v; 193 ® 120 in132_t index, ~
demolodeEvents. nurEvents++: 194 130 int32 t =
) w5 131 32t ¥)
126 132
197 133 ]
oid Libria DemollodeRecordinputEyent (DENO_MODE_INFUT_TYPE te, 128) |13
int32_t index, 129 135 static veid LibAria LoadDefaulrfvents(void)
int32 t x 1o 136 1
int32_t ¥) 131 137 // START OF CUSTOM CODE. DO NOT MODIFY OR REMOVE!!!
{ 138 megammmﬂmumum(mna. DENO_MODE_INPUT_PRESS, 0, 0x26, 0x07F
139 Fyent (0282, DENO_NODE_INPUT_RELEASE, 0, 0x26, 0xOTF
140
static void LibAria LoadDefauliEyents(void) 141 //Turn the 1ist wheels
{ 142 Lthﬂmmﬂmmmmxm DENO_MODE_INPUT_PRESS, 0, 0x87, 0x09D)
// Add default imput events here. These will be loaded if no events were 143 putByent (0328, DENO_MODE_TNPUT_NOVE, 0, 0x87, 0x99);
// recorded. 144 mmmm;mmmm(mm DENO_MODE_INPUT_MOVE, 0, 0x88, 0x93);
07 e i D e e Cailes, Saths, oy, o T 145 putEyent (0x14, DENO_NODE_INPUT_MOVE, 0, 0x8A, 0x08C);
146 memmﬂmmm(um DENO_MODE_INFUT_MOVE, 0, 0x8D, 0x07D);
147 LibAria DemolodeAddTnputEvent (0x14, DENO_MODE_INPUT_MOVE, 0, 0x91, 0x62);
oid LibAzia DemelodeT uchDownbandlex (const. STS_INE TonchStatelventt const ext) 2] 148 Libiria DemallodeAddInputEyent (0x4, DENO_NODE_INPUT_WOVE, 0, 0x96, 0x45).
{ 143 149 LibAria DemolodeAddTnputEvent (0x001E, DENO_MODE_INPUT_RELEASE, 0, 0x96, Ox4
LibAria_DemolodeSendEyent (DEMO_EVENT_INPUT) : 144 150 LibAria_DemoModeAddInputEyent (0x02C6, DENO_MODE_INPUT_FRESS, 0, 0xCE, 0x09B
us| 181 LibAria DemellodeAddlnputEvent (0x28, DENO_NODE_TNPUT MOVE, O, 0xCF, 0x98);
146 152 LibAria_DemolodeAddTnputEyent (0x001E, DENO_MODE_INPUT_MOVE, 0, 0xD0, 0x92);
oid LibAria DemelMlodeTouchUpHandlex (const SYS_INP TeuchStatsBvent® const svi) 147/ | 153 LibAria_DemollodeAddInputEvent (0xA, DENO_MODE_INPUT_MOVE, 0, 0xD1, 0x08D);
{ 148 154 LibAria_DemoModeAddInputEvent (0x14, DENO_NODE_INFUT_MOVE, 0, 0xD2, 0x86);
LibAria DemollodeSendEyent (DENO_EVENT INPUT) : 149/ [ 155 LibAria_DemollodeAddInputEvent (0x14, DENO_NODE_INPUT_NOVE, 0, 0xD4, 0x78);
150 156 o LibAria DemoModeAddInputEvent (0xA, DENO MODE INFUT MOVE, 0, 0xD6, 0x05E); 5 v
157

21




